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1 Introduction

The Neuralynx Hardware Processing Platform (HPP) runs code developed on a PC and is downloaded
through a USB connection. This “Getting Started Guide” walks you through the process of getting the HPP
development environment installed and tested.

2 Installing Xilinx Development Software

The development software used with the HPP is the Xilinx Vivado and SDK. The first step is to download
this software. Use this link for the download web page:
https://www.xilinx.com/support/download/index.html/content/xilinx/en/downloadNav/vivado-design-tools/a

rchive.html

XILINX Applications Products Developers Support About s m@ Q

Xiling - Adaptable. Intelligent. » Support » Downloads

Vivado Installation Overview Video Licensing Help Alveo Accelerator Card Downloads ~
Vitis Embedded
Vivado (HW Developer) Vitis (SW Developer) Platforms Petalinux Device Models
2014
Version
2014.4
2019.2
2019.1 20143
2018.3
. 20142
ISE Archive
20141

CAE Vendor Libraries
Archive

Vivado Design Suite - 2014.1 Full Product Installation

& Vivado 2014.1 Full iImage All OS with SDK (TAR/GZIP - 7.26 GB) Boanic=tinciGdes Dt eation
NavlgaTD!

MD5 SUM Value 1 Software Development
Kit (SDK)
System Generator for

& Vivado 2014.1 Full Image for Windows with SDK (TAR/GZIP - 5.1 DsP

GB) Vivado Design Suite (All
Editions)

MD5 SUM Value : f58f1c876e44e51759b42e82dd7bdcec Vivado High Level

Synthesis (HLS)

Vivado WebPACK (Free)
& Vivado 2014.1 Full Image for Linux with SDK (TAR/GZIP - 5.09 GB)

Download Type Full Product Installation
MD5 SUM Value : 14664941bc5addd0b933cc2a139477e1

Last Updated Apr 16,2014

Answers 2014.1 - Vivado Known
Important Information Issues

Documentation 2014.1 - Release Notes

Having trouble downloading? The downlead links above require the
i ion and use of a b based (plug-in) manager. Enablement License Solution Center
‘Your company's policy and/or firewall settings may not permit the
download manager to be installed or cperate properly. If you wish to
bypass the use of the Xilinx download manager, please see AR#
60027.

Order DVD Design Suite DVD

The version to download is “Vivado Design Suite - 2014.1 Full Product Installation”.
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For this guide, we will target a Windows development environment. Vivado 2014.1 Full Image for Windows
with SDK (TAR/GZIP - 5.1 GB). A Xilinx user account will be required for download. If you do not already
have one, you can sign up for a free Xilinx account using the “Create your Account” link.

After the file has been downloaded, unzip and untar the compressed files. If you don’t have an application
installed that can unzip and untar a file, you can download the latest version of 7-zip from www.7-zip.org.
Once the installation files have been decompressed, run the xsetup.exe executable located in the
extracted Xilinx_Vivado_SDK_Win_2014.1_0405_1 folder.

Welcome

VIVADO/

We are glad you've chosen Xilinx as your platform development partner. This program can install the Vivado Design
Environment, Software Development Kit, Hardware Server and Documentation Navigator.

‘You will need to have administrator privileges in order to install this software.

To reduce installation time, we recommend that you disable any anti-virus software before continuing.

§. A Newer Version |s Available b 4

¥ilinx Design Tools 2019.2 is now available.

Click Get Latest to download this latest version and cancel this installation.
Click Continue to continue with this installation of Xilinx design Tools 2014. 1.

& XILINX

ALL PROGRAMMABLE.

Copyright © 1586-2020 Xilinx, Inc. Al rights reserved. PN Newt = T
< Back

Xilinx Vivado Installation

If the installation prompts to install a newer version, select “Continue” to proceed with installing the
2014.1 version of Xilinx Design Tools. (Neuralynx plans to release an updated HPP platform to support
newer versions of Xilinx Development tools in the future).
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Once the installation process has been started, you will be prompted for the edition to install. You should
select the “Vivado Design Edition”.

¥ Vivado 20141 Installer - Select Edition to Install — | X

Select Edition to Install

lect an edition to continue installation. You will be able to customize the content in the next page. XI LI NX
ALL PROGRAMMABLE -

() Vivado WebPACK

Vivado WebPACK is the no cost, device limited version of the Vivado Design Edition.

(@) Vivado Design Edition

Vivado Design Edition indudes Vivado Design Suite with complete device support, cable drivers and Documentation Mavigator. Users can optionally add
Software Development Kit to this installation,

() Vivado System Edition

Vivado System Edition iz a superset of Vivado Design Edition with the addition of Vivado High-Level Synthesis and System Generator for DSP. Users can
optionally add Software Development Kit to this installation.

() Software Development Kit (Standalone)

Software Development Kit (SDK) is an Edipse-based package used to create and debug embedded software applications, This is a standalone installation
without Vivado Design Suite.

(") Hardware Server (Standalone)

The hardware server enables Vivado Design tools to communicate with & remote target system. This standalone installation indudes hw_server and ITAG
cable drivers but does not indude Vivado Design Suite.

() Documentation Navigator (Standalone)

Xilimx Documentation Navigator (DocMav) provides access to ¥ilinx technical documentation both on the Web and on the Desktop. This is a standalone
installation without Vivado Design Suite.

Copyright © 1586-2020 Xilinx, Inc. All rights reserved. T || R || P

Edition to Install
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Install with the following options selected:

¥ Vivado 2014.1 Installer - Vivado Design Edition = O X

Vivado Design Edition

elow. Moving cursor over selections below provide additional XI LI NX
information.

ALL PROGRAMMAELES

Vivado Design Edition indudes Vivado Design Suite with complete device suppaert, cable drivers and Documentation Mavigator, Users can optionally add
Software Development Kit to this installation.

=I-§4 Design Tools
(= [H] Vivado Design Suite
! Yivado
System Generator for DSP
‘ivado High Level Synthesis
Software Development Kit
DocMaw
[Z-<_» Devices
E} |:| 7 Series
L[ Artix-7
[ Kintex-7
e [ Wirtex-7
Zyng-7000
= [] Ultrascale
i [ ]  Kintex UltraScale
[1 wirtex UltraScale
=¥ Installation Options
Enable WebTalk to send software, IP and device usage statistics to Xilinx (Always enabled for WebPACK license)
Install Cable Drivers
Acquire or Manage a License Key
Install WinPCap for Ethernet Hardware Co-simulation
Launch configuration manager to assodate System Generator for DSP with MATLAB

KIKIE]

Download Size: NA s
Disk Space Required; 12,29 GB i ]

Copyright © 1586-2020 Xilinx, Inc. All rights reserved, | it || Next = | cancel

Vivado Design Edition Install Options

At a minimum, ensure that

1. The “Software Development Kit” option is selected under Design Tools,

2.“Zynqg-7000" option is selected under Devices, and

3. “Install Cable Drivers” and “Acquire or Manage a License Key” is selected under Installation Options.

Rev.2.0 1/17/2020
Hardware Processing Platform (HPP) Getting Started Guide



Neuralynx

The Complete Solution for Electrophysiology Research

When the installation finishes, the Vivado License Manager will open. Select “Obtain License” under

Getting a License.

E Vivado License Manages = O *
File Help

4 Getting a License

Proxy Settings

: :_‘h‘ Load License

Managing My Licenses

(¥ License Search Locations
% View License Status

4 System Settings

----- @ System Information

Select “Get Free Licenses - Vivado WebPack, SDK, free IP and more”, then click the “Connect Now” button.

Rev. 2.0

1/17/2020
Hardware Processing Platform (HPP) Getting Started Guide

Select one of the following options

() Start Mow! 30 Day Trial (Mo Bitstream)

(®) Get Free Licenses - Vivado WebPACK, SDK, free IP and more
(") Start 30 Day Evaluation

() Get My Purchased License(s)

Connect Now Save Information

Description of the above selected option

Get a free Vivado/ISE WebPack license and start using yvour Xilinx software.
You will be taken to the Xilinx website where you can generate a license
for Vivado/ISE WebPack. For more information on Vivado/ISE WebPack,
including supported devices and applications, please visit www.xilinx.com.

Note: WebTalk is always enabled for WebPACEK users. WebTalk ignores user and
install preference when a bitstream is generated using the WebPACK license.
If a design is using a device contained in WebPACK and a WebPACK license is
available, the WebPACK license will always be used. To change this, please
see Answer Record 34746.

Lfter the license is generated and you have saved it to your machine, click
on the Load License selection to either copy your .lic file to a default
location, or to load your .xml response file into trusted storage.

Vivado License Manager
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You will need to sign up for a free Xilinx account using the “Create your account” link to get a license for
the Xilinx software if you have not already done so.

B8] & sionim ><L+ ~ ET B

O @

https:/wwwadlinx.comy/registration/sign-in htmizoamPr

XILINX Applications Products Developers Support About AaW©OQ

ent. > Signin

Sign In

Username *
Password*

Forgot your username or password?

New to Xilinx? Create your account

By signing in, you agree to the Xilinx Terms of Use
and Privacy Policy.

Xilinx Account Sign In Page

Continue to enter your required information:

|
XILINX [ = dsen @

L & nttps://securesilim.com/wetn O + @ © || @ Registration - Create Acco..

APPLICATIONS PRODUCTS DEVELOPER ZONE SUPPORT \BOUT

Create Account

Instructions

To complete your account creation, a validation e-mail will be sent to you Rules for your User I

Fieids marked with an asterisk * are required
Your user ID must be at least 3

* characters long, all lowercase, must
UseriD xlinx_hpp_development coniain at least 1 letier and may contain
any of thess special characters; at
symbol (@), dash (-), period () or
underscore ()

Corporate Email * xilinx.hpp.development@gmail con iR o Vi s

Password * [ —— Your password must be at least 3
- e characters long, must contain at least 1
letter, 1 number and 1 special character

password cannot be the same.

First Name * [hPP

Last Name * Development

By clicking "Create Account” below, you agree to our Terms of Use and that you have
read our Privacy Policy, including our use of cookies.

Create Account

Your User 1D will be displayed to ofhers when you post on Xiiinx Community Forums.

I

iny f3Iro@E@

Account information
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e I & https://securexilin.com/webr L-ac ” 2! Registration - Xilinx Registr... | |

&sienin | @

APPLICATIONS PRODUCTS DEVELOPER ZONE SUPPORT ABOUT

Activate Your Account

Your Xilinx.com account has been created but not activated. An E-mail has been sent to xilinx.hpp.development@amail.com. Please follow the instructions in the E-mail to
activate your account and continue with the regisfration process.

Thank you,
Kilinx, Inc.

iny f3 @ &MD

pyright 2016 Xilinx Inc_| Privacy | Trademarks | Legal | Feedback | Contact Us

Activate Account

Click on the link in your email to activate your account. This will take you to the Xilinx login webpage.
Sign in with your newly created account.

Enter the required profile information (indicated by *) and click “Save Profile.”

Return to the Vivado license manager. Click on “Obtain License” and select “Get Free Licenses - Vivado
WebPack, SDK, free IP and more.” Then click “Connect Now.” This will take you back to the licensing web

page.

Rev.2.0 1/17/2020
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From the Product Licensing web page that opens, verify your user information and click “Next.”

o & https://securexilinecom/went O ~ @ & || {22 Xilinx Registration | ‘

XILINX

My Account | & Sign Out | @

APPLICATIONS PRODUCTS DEVELOPER ZONE SUPPORT ABOUT

Product Licensing

US export regulations require that your First Name, Last Name, Company Name and Shipping Address be verified before Xilinx can fulfill
your request. Please provide accurate and complete information for immediate processing. Sorry, addresses with Post Office Boxes
and names [ addresses with Non-Roman Characters with accents such as grave, tilde or colon are not supported by US export

compliance systems.
Fieldzs maried with an asfenzk * are required.

Frethame T

Last Name * Development

Address 1* 105 Commercial Dr

e 1
PostaliZip Code * 59715

Country * [United States v
State/Province [Select One v]
Phone (include area code) * ADB5854542

Corporate Email xilinx hpp development@
conpanyiorgnzton (T

Job Function * Engineer-Systems v

Primary Market * [Medical v

1/17/2020

Product Licensing Information

Hardware Processing Platform (HPP) Getting Started Guide
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Check the box in “Certificate Based Licenses” for “Vivado Design Suite: HL WebPACK 2015 and Earlier
License” and click “Generate Node-Locked License.”

é |. https://xilinxentittenow.com/: © ~ & & | . xilinx.entitlenow.com

XILINX el ] aswoaisiwe

AMABLE.

APPLICATIONS PRODUCTS DEVELOPER ZONE SUPPORT ABOUT

Home : Support : Product Licensing

Product Licensing

Create New Licenses Manage Licenses

Have a Voucher to Redeem? ? EQ Evaluation and No Charge Cores ?
® =] 000600000C00M-00000000 O :
L] . o=  Search the Evaluation and No Charge
enter voucher code Redeem Now cores catalog and add specific cores to m

table below

Create a New License File
Create a new license file by making your product selections from the table below. ?

Certificate Based Licenses

Product Type License Available Status Subscription End
Seats Date
Certificate - Mo Charge Node 11 Current Meone
~

Certificste - Evaluation Node 1 Current 30 days
Certificate - Mo Charge Node 11 Current Mone
Certificate - Evaluation Node 11 Current 365 days
Certificate - Evaluation Node 11 Current 30 days ™

Generate Node-Locked License v

Generate License

10
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This page will use a host ID from the current PC to license the development software.

(=] [=lla@]=]

(- |. https:/ /xilinc.entitlenow.com/s © ~ @ O || B silinx.entitlenow.com (nr 3-8 508

XlLINX |A[\—v | & signout | @ |= ()

MABLE.

APPLICATIONS PRODUCTS DEVELOPER ZONE SUPPORT ABOUT

1 PRODUCT SELECTION
Home : Support © Product

Product Lit seectons B st || hacie I e I e
= [ g 1

. NoCharge 111 MNene

Help

Create New License!

i < >
Have a Voucher to Re
: :[ KAHKK-YHRIHK-XHKHK -0

r—— ZSYSTEM INFORMATION W

License Node
Create a New License File HostID": Any
Create a new license file by
Certificate Based Licenses
Date
“Wivado Design Suite; HL Wel 3 COMMENTS nt Mone
~
|:| ivado Design Suite (No ISE)} nt 30 days
Comments z
D ISE WebPACK License nt Mone
D Petalinux Tools License nt 365 days
“ivado HLS Evaluation Licens nt 30 days bt
]
<

g >
= Cancel
Generate Node Locked L m = v "

Obtain Host ID

Rev.2.0 1/17/2020
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|. https://wilinxentitienow.com/: © ~ @& & | . xilinx.entitlenow.com

XILINX (a-

{AMMABLE.

APPLICATIONS PRODUCTS DEVELOPER ZONE SUPPORT

Home © Support © Produgt Product Selections

N S
Product Lit - I i

PACH 5 and Earlier...

sign Suite: HL

Create New Licens@ System information
License Node

Have a Voucher to Re
: :l sooocoooomooose  1OstID ANy

enter voucher code

Create a New License File

Create a new license file BY note: webTalk is always enabled for WebPACK users. WebTalk ignores user and install
preference when a bitstream is generated using the WebPACK license. If a design is using a
Certificate Based Licenses device contained in WebPACK and a WebPACK license is available, the WebPACK license

_ will always be used. To get additional information on WebTalk, go to www.xilinx.com/webtalk.
“ivado Design Suite: HL Web m m Cancel

D “ivado Design Suite (No ISE)}

El ISE WebPACK License
(=] Petalinux Tools License

Bl “ivado HLS Evaluation Licens

< |

Generate Node-Locked L

=] EErE]

& Signout | @ | = ()

ABOUT

Help

fatus Subscription End
Date

nt Mone

~
nt 30 days
nt MNene
nt 365 days
nt 30 days

License Information Window 1

1/17/2020

Hardware Processing Platform (HPP) Getting Started Guide
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(=] (== s
e |. https://wilinxentitienow.com/: © ~ @& & | [ silinx.entitlenow.com it 75 %6
XlLINX | All ~ | & Signout | @ | = ()
A IMABLE. )
o ~ . - -
APPLICATIONS PRODUCTS DEVELOPER ZONE SUPPORT ABOUT
Home : Support : Product X
P ro d uc t L| C Congratulations
Your new license file has been successfully generated and e-mailed to
ilinoe. hpp.development@gmail.com. You can also view the license file under the Manage Licenses tab. Heln
Help
Please add this sender (xilinx.notification@entitlenow.com) to your address book.
Create New Licenses License File Details
Node License
i | 12 OCT 2016
Products
Vivado Design Suite: HL WebPACK 2015 and Earlier License (No Charge): 1 seats
< >
Comunexis Product Type Status  Subscription Activated
End Date Seats
Wi Design Suite: HL WebPACK 2015 and Earlier License Certificate - No Charge Vivado Design Suite: HL WebPACK 2015 and
Earlier License

License Generation Complete

13
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A Xilinx license file will be sent to your provided email address from xilinx.notification. Download the
“Xilinx.lic” file to a known location.

Return to the Vivado License Manager. Select on “Load License” under Getting a License and click the
”Copy License” button.

-
f:_r_-i Vivado License Manager |ﬂ| |£”£”E|
File Help

A: Getting a License Load License

5 Proxy Settings
{3 Obtain License

Certificate Based Licenses

2

E""":ﬁ Click the 'Copy License' button to copy a certificate-based license (lic file) into the local Xilinx directory. Xilinx applications
4 Managing My Licenses automatically detect valid, node-ocked licenses (*.lic) residing in the local . Xilinx directory.

i ('ﬁ' License Search Locations -

i ﬁ View License Status

.71 Return License to ¥ilinx
4 System Settings Activation Based Licenses

(E System Information
Click the 'Activate License' button to load a response XML file into VLM to activate your machine for Xilinx tools and IP.

Activate License...

Load License

Browse to your downloaded “Xilinx.lic” license file and click “Open”. Click “Ok” to close the “license
installation was successful” message box. Close the Vivado License Manager and complete the Vivado
installation.

14
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3 Programming a Project on the HPP

Download the provided base example project for the HPP from:
https://www.dropbox.com/s/wyvnl9gtwokvclc/HPP v1.0.0.zip?dl=0

| <—EII 22 HPPV1.0.0zip % I+ > . 5 »
S O & Dropbox, Inc [US] | httpsy//www.dropbox.com/s, e = 7 e
3 HPPv1.0.0.zip B N i5
Direct download
Mame Size .
Save to my Dropbox .0.0.Z|p @
HPPv1.0.0 Details 5
Size
116.3 MB

View all details

Select “Direct download” to download the compressed HPP_v1.0.0.zip project. Extract the project to a
folder onto your development PC.

The generated HPP bitstream and demo ELF files will be programmed through JTAG using the Xilinx SDK
2014.1 software. Open Xilinx SDK 2014.1.

@ Workspace Launcher *

Select a workspace

Kilinx SDK stores your projects in a folder called a workspace.
Cheoose a workspace folder to use for this session,

WL R LR\ HPP v 1.0.00HPP_v1.0.0\FreeRTOS\Workspace] ~ Browse...

[[]Use this as the default and do not ask again

Select the workspace directory of the extracted project located at
<your_proj_dir>\<proj_name>\HPP_v1.0.0\FreeRTOS\Workspace.

15
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In the SDK Project Explorer on the left, right-click on “RTOSDemo” and “RTOSDemo_BSP” folders and
select “Delete” from the menu.

B e+ - Xilinx SDK B Delete Resources O X
el B el e Ll % Are you sure you want to remove these 2 projects from the workspace?
LI:L} - | By v > T @ - Elﬁ - 'E? - G
B e v oG R i x [ Delete project contents on disk (cannot be undone)
(F Project Explorer 57 = & | ¥~ =GO .. Project locations:
% hpp_v1.0.0_hw_platform_0 {I\HPP_v1.0.0\FreeRTOS\FreeRTOS\ Dema' CORTEX_A8_Zyng_ZC702\RTOSDemo
=] RTOSDemo |EANHPP_v1.0.0\FreeRTOS\FreeRTO5\Demol CORTEX_AS Zynq ZCT02\RTOSDemo_bsp
i RIOSDe——+— 7
New >
= Copy Ctrl+C
Paste Ctrl+V
#  Delete Delete Preview = Cancel
Maove,

Click “OK” to confirm the deletion.
Warning: Do NOT select the “Delete project contents on disk (cannot be undone)” checkbox as this could
permanently delete your project folders from a copied location.

Select menu option “File -> Import...” or right-click in Project Explorer and select “Import...”, then
choose “Existing Projects into Workspace” under “General” and click “Next” to continue.

Click the “Browse” button to the Select root directory:
<your_proj_dir>\<proj_name>\HPP_v1.0.0\FreeRTOS\FreeRTOS\Demo\CORTEX_A9_Zynq_ZC702\

Select “RTOSDemo” and “RTOSDemo_bsp” in Projects.
Warning: Do NOT select “Copy projects into workspace” since this will cause pathing dependency issues
when rebuilding the project.

16
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Research

-
Import

Import Projects

[=]

Select a directory to search for existing Eclipse projects.

@ Select root directory:  CAXilinxProjects\HPP\HPP_SfM'\FreeRT(OS\Free
() Select archive file:

Projects:

= &=

| &

Browse...

Browse...

RTOSDemo (Ch\XilinkProjects\ HPP\HPP_SfN\FreeRTOS\FreeRTOS
RTOSDemo_bsp (ChXilinkProjects\HPP\HPP_SfMN\FreeRTOS\Freef

4 ]

[] Copy projects into workspace
Working sets

[] Add project to working sets

Select All

Deselect All

Refresh

Select...

J |

Cancel

Import Projects

1/17/2020

Click “Finish” to complete the import of the project into the active project workspace.
Right-click on RTOSDemo in the Project Explorer and select “Clean Project” to clean and rebuild the
project contents.

17
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4 Running an Application on the HPP

The HPP uses a serial command-line interface (CLI) to interact with the operating system. You must have
the required USB to UART Bridge Virtual COM Port (VCP) driver installed on the PC.

Download and install the latest Silicon Labs CP210x Windows VCP driver from
https://www.silabs.com/products/development-tools/software /usb-to-uart-bridge-vcp-drivers

If you haven’t already done so,
e Attach a USB cable from the development PC to Digital Lynx SX port “HPP Terminal”

e Attach a USB cable from the development PC to Digital Lynx SX port “HPP JTAG”

In Windows Device Manager, make a note of the COM port number “Silicon Labs CP210x USB to UART
Bridge” connected to your HPP USB Terminal. The baud rate is 115200.

File Action View Help
= FEEE P kX®
v % DESKTOP-30MNSRCP

I Audio inputs and outputs
3 IE Computer
- Disk drives
@ Display adapters
= DVD/CD-ROM drives
3 i Firmware
i Human Interface Devices
@ Jungo
E= Keyboards
3 @ Mice and other pointing devices
[ Monitors
@ Metwork adapters
v i Ports (COM & LPT)
ﬁ Silicon Labs CP210x USE to UART Bridge (COM15)
™ Print queues
] Processors
B Software devices
» U Sound, video and game controllers
S Storage controllers
Em System devices
i Universal Serial Bus controllers

Windows device manager view of COM ports

18
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To connect the PC for terminal access, a terminal program such as Tera Term or PuTTY is required.

If you don’t already have a terminal program, you can download the latest version of Tera Term from
https://ttssh2.0sdn.jp/index.html.en

Or PuTTY from
https://www.chiark.greenend.org.uk/~sgtatham /putty/

The Xilinx SDK 2014.1 also provides a built-in terminal module. If the Terminal module window is not
shown, select from the menu “Window -> Show View -> Terminal”.
In the Terminal module window select the “Settings” icon (third icon from the left that looks like a note

sheet 0).

B Terminal Settings X

View Settings:

View Title: | Terminal |

Encoding: | 150-8859-1 v]

Connection Type:

Serial At
Settings:

Port: COM15 e
Baud Rate: 115200 ~
Data Bits: 8 e
Stop Bits: 1 ~
Parity: |None ~
Flow Contrel: |Mone e

Timeout (sec): | 5

SDK Terminal Settings - serial port setup

In the Terminal Settings dialog, set “Connection Type” to “Serial” from the drop-down menu. In “Settings”
choose your COM “Port” number connected to your HPP. Set the “Baud Rate” to 115200.

In the Terminal module window click the “Connect” icon (first icon from the left & ) to connect to serial
port.

19
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In the SDK Project Explorer, right-click on RTOSDemo and select “Run As -> 1 Launch on Hardware
(GDB)”. This will create a default run configuration “RTOSDemao.elf” for this application.

In the SDK menu, select “Run -> Run configurations...” to edit the default run configuration. In the Target
Setup tab, select the “Reset Entire System” option from the drop-down list and select the “Program
FPGA” checkbox. In the Bitstream file box, click “Search...” and choose hpp_top.bit to select the bitstream
file to download to the HPP FPGA. Click the “Apply” button to save and then “Run” to program the HPP
over JTAG.

HR® Run Configurations .4

Create. manage, and run configurations —

BEER A= R

T || Name: | RTO5Demo.elf ‘
type filter text @ Targe‘t Setup G Applicatior‘l‘ Y STDIO Conne&ion_ |! Profile Optinn; =] Cnmmon..
[€] C/C++ Application
[€] C/C++ Remote Application Debug Type: | Standalene Application Debug  ~

= Launch Group
_é Remote ARM Linux Application
‘E Target Communication Framework Device: Auto Detect Select
v & Xilinx C/C++ application (GDE)
£ RTOSDemo.elf

GOE

Connection: |L0ca| V| New

Hardware platform: | hpp v1.0.0_hw_platform 0 ~
Processon ps7_cortexad 0 w
Bitstream file: | hpp_top.bit | Search... | | Browse...
Initialization file: | ps7_init.tcl | Search... | | Browse...

Summary of operations to be performed

Reset Entire System  ~ Following operations will be performed before launching the debugger.
1. Reset entire system.
Program FPGA 2. Program FPGA fabric (PL).

o 3. Run psi_init. (Only first time after System reset or board power ON)
oy pe it 4. Run ps7_post_config. (Only first time after System reset or board power ON)
Run ps7_post_config 5. 'IAHPP_v1.0.0\HPP_v1.0.0\FreeRTOS\FreeRTOS\Dem o\ CORTEX_AS_Zynq_ZC702\RTOSDemot\Debugh\RTOSDemo.elf will

[ Enable Cross-Triggering be downloaded to the processor 'ps7_cortexad_0f

Appl Revert
Filter matched 7 of 10 items PPy

;
®

Run Configurations setup

This will begin a programming process visible in the lower right progress bar. This process usually takes
approximately 15 seconds as it configures the FPGA, and downloads the bitstream and application.
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Verify the following output is received over the serial connection in the Terminal window.

Ig?yknnhﬂ %?\ﬂx R O = | IQ,EE| &g =0
Serial: (COM15, 115200, 8, 1, None, None - COMNECTED) - Encoding: (150-8859-1)

Cleared File and Data DDR locations.

Semaphores created and taken

[HPP Parameters Loaded from Flash:

ID: 0x48505021 ("HPP!"™)
Firmware Version: 1.00
[HPEF IP: 182.168.5.10

Waiting for DLSX synchronization.

vFile System Task created with return value of 1
FreeRT0S command server.

Type Help to view a list of registered commands.

Type “help” and press Enter, to output a list of registered commands currently implemented in the HPP.
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For more information or questions, please contact:

HPP_Support@neuralynx.com / 406-585-4542
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